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Introduction to Project Tracker

Project Tracker is a Windows based application that imports project information from Primavera P6,
Microsoft Project and Asta Powerproject to create Earned Value and S-Curves and Reports which are used
to analyze the progress of the project.

An S-Curve is a graphic representation of cumulative costs, man-hours or time, measured against the overall
project plan. It is an ideal tool for managers to quickly assess where the project stands in terms of
completion, deadlines, and budget.

Additionally, many clients will ask for an S-Curve report as part of regular reporting updates.

Most project management software applications do not provide in built S-Curve capability. Users generally
export data to a spreadsheet, in applications such as Microsoft Excel, to plot the curves.

This method requires a number of steps and a certain level of knowledge including how to add resources or
costs to the plan, how to create time phased exports from the PM tool, how to open the data in the
spreadsheet and how to create graphs from the data. Project Tracker eliminates all of these steps.

Aside from the number of steps required to export data from PM software to a spreadsheet, this method is
accepted as an important reporting medium. The problem with this method is that the analytical possibilities
are not available as the data is disconnected from the actual plan.

Therefore, rather than just importing the  data required to plot a curve, Project Tracker imports the activity
data and allows the user, if required, to plot a Gantt Chart under the S-Curve.  This allows those that are
viewing the data to assess which activities may be causing issues and what action can be taken.

One major benefit of Project Tracker is that it will create an S-Curve using the durations of activities. For
those that plot S-Curves using the spreadsheet method, resources and/or costs are required to be added to
the project plan before the data is exported. With Project Tracker, this is not a requirement for the S-Curve
to be generated.

Project Tracker will plot resource and cost curves but the ability to use duration data is unique.

Project Tracker plots 

Actual (the duration or cost or man hours complete at the data date)
Forecast (the remaining duration or cost or man hours in the plan)
Mix Forecast (a user defined mix between the early and late remaining duration or cost or man hours in the
plan)



Project Tracker

5 / 73

Early Forecast (the remaining early duration or cost or man hours in the plan)
Late Forecast (the remaining late duration or cost or man hours in the plan)
Earned Value (the earned value or BCWP)
Baseline 1 (the duration or cost or man hours in a baseline)
Baseline 2 (the duration or cost or man hours in a second baseline)
Predicted (the curve based on the duration or cost or man hours in the plan and adjusted using the current
slippage and project growth at the data date)
Recovery (the curve based on the duration or cost or man hours in the plan and adjusted to complete by a
date specified by the user)

Project Tracker will also plot a per period bar graph of baseline and forecast values. This is useful to see if
too much or too little work has been planned at specific dates in your project.

Project Tracker allows graphs to be created by a WBS hierarchy, Activity Code or Resource. This is very
useful for creating S-Curves by contractor or by floor or by section or by resources of the project; something
not possible using the spreadsheet method.

The unique features of Project Tracker will mean that more people will want to see the data being produced.
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Your reporting cycle will determine when the information is required but for different audiences, different
views of the report may be required. Project Tracker allows the creation of Views and they can be based on
a WBS/Code filter/Resource. When created, they can save the user time and can then be set to batch print
so that all reports can be created with a single click.

Text can be added to the S-Curve to provide further information. The text can be formatted as required.

The data that is displayed in the S-Curve is also translated into a text based Progress Report. This gives
high level progress information and detailed description of the figures that underlay it. The progress report
can be edited, saved and printed.
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This report can also show earned value data

Project Tracker allows dynamic tracking of where the project is by moving the mouse over the forecast
curve. A feedback dialog shows where the project currently is against its planned position.



Project Tracker

8 / 73

As the mouse passes over each date, the activities occurring at that point can be viewed. This list is
dynamically updated as the mouse moves. This again is useful as it links the curves with the data in the
plan.

Each report can be printed with a company logo and version numbering.

Four other reports are available; Milestone Trend Analysis, Dashboard, Project Quality and Activity Reports
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Finally Project Tracker is very easy to learn, and is fully configurable.

Created with the Standard Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation

Key Benefits of using Project Tracker

1. Import projects and baselines from Primavera P6 

2. Import projects and baselines from Microsoft Project

3. Import projects and baselines from Asta Powerproject

4. Create Earned Value graphs and S Curves without assigning costs or resources

5. Create Earned Value graphs and S Curves without having to export to Excel

6. Payback after first progress reporting period with one click S Curves

7. View Gantt chart under S Curve

8. Milestone Trend Analysis

9. Dashboard Reports

10. Project Quality Reports

11. Filter by WBS, Activity code and Resource

12. Batch print for multiple one click reports

13. Text based progress reports included

14. Add text to curves

15. Create and save views of filtered curves

16. Dynamic feedback of progress status at any point on curve

17. Create forecast lines based on current progress rate

18. Create recovery program lines

19. Activity properties pane to view activities due at any point in project.

20. Save data to XML to share with other users

Created with the Standard Edition of HelpNDoc: Free help authoring environment

System Requirements

Supported Operating Systems

Windows Server 2003, Windows 7, Windows Server 2008, Windows Vista, Windows XP, Windows 8,
Windows 10

32 and 64 bit operating systems supported

https://www.helpndoc.com/help-authoring-tool
https://www.helpndoc.com/help-authoring-tool
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·Processor: 400 MHz Pentium processor or equivalent (Minimum); 1GHz Pentium processor or
equivalent (Recommended) 64 bit required

·RAM:96 MB (Minimum); 256 MB (Recommended)

·Hard Disk: Up to 500 MB of available space may be required

·CD or DVD Drive: Not required

·Display: 800 x 600, 256 colours (Minimum); 1024 x 768 high colour, 32-bit (Recommended)

Created with the Standard Edition of HelpNDoc: Produce Kindle eBooks easily

Installation

To install Project Tracker double click ProjectTracker.exe and follow the instructions.

It is recommended you follow the default installation options.

Click Next

https://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
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Click Next.

Click Next
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Check the license agreement and if you agree with it click I Agree and then Next

Click Close to complete the installation.

Created with the Standard Edition of HelpNDoc: What is a Help Authoring tool?

https://www.helpauthoringsoftware.com


Project Tracker

14 / 73

Licensing and Trial Version

Project Tracker has a perpetual license.

Project Tracker will operate in trial mode for 15 days with no loss of functionality.

Licensing

If you have purchased Project Tracker you will have received a license key and password by email. 

Click Activate Project Tracker

Select Activate Project Tracker Online
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Enter license details you have been sent into the dialog when you start Project Tracker. You will receive a
message saying if the activation has been successful.
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Created with the Standard Edition of HelpNDoc: News and information about help authoring tools and
software

Getting Started

The first thing to do is import data from your planning software; be it Primavera P6, Microsoft Project or Asta
Powerproject...

Irrespective of the software you use the project should have some activities and these should be baselined.
You can import up to 2 baselines to compare against, typically an as soon as possible baseline and an as
late as possible baseline. However, the baselines are up to you and could be of the original plan and a
revised plan...

Whichever software you are going to import from; you must have started Project Tracker Specific
requirements for each software are detailed in the relevant section.

Created with the Standard Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation

Getting Around

Project Tracker is a simple application with very few dialog boxes or complicated things to learn. The most
important thing is getting your project right and finishing on time!

The main window and operations are controlled by the ribbon.

https://www.helpauthoringsoftware.com
https://www.helpauthoringsoftware.com
https://www.helpndoc.com/help-authoring-tool
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Created with the Standard Edition of HelpNDoc: Full-featured EBook editor

Ribbon and Menus

The first item to look at is the Ribbon Menu. You access this by clicking the File Option in the top left of the
window.

This drops down the menu. Note menus and ribbons are context sensitive and you can only select what is
valid at that time.

 

https://www.helpndoc.com/create-epub-ebooks
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Open - will open a saved Project Tracker xml file

Save - will save data to a Project Tracker xml file

Recent Files - lists recently opened files.

Close  - will close a project

Properties - change the displayed name of the project

Print - will print the current display

Print Settings - will set the orientation and logo to be used in print outs

Activate - will present the dialog to activate the license

De-Activate - use this to de activate the license to move to another machine

Exit - will close Project Tracker

 

Created with the Standard Edition of HelpNDoc: Easy to use tool to create HTML Help files and Help web sites

Home Tab

The Home Tab deals mainly major operations such as saving, printing, importing and exporting.

Save - saves the current project to a Project Tracker xml file

Batch Print - prints every view that is set to batch print. This allows multiple curves to be printed with one
click.

Preview - will post a preview of how the current view will look on paper when printed

Copy - will make a copy of your S curve that can be pasted into Microsoft Word, Excel etc

Primavera - click the arrow to select P6 import options

Primavera P6 Database - enable the user to import from Primavera P6 databases

Primavera P6 XER - enable the user to import an XER file from Primavera P6

Primavera P6 XML - enable the user to import an XER file from Primavera P6

https://www.helpndoc.com/help-authoring-tool


Project Tracker

19 / 73

Asta Powerproject - imports an Asta Powerproject project

Microsoft Project - click the arrow to select P6 import options

Microsoft Project - imports from Microsoft Project

Microsoft Project XML - imports an XML file created in Microsoft Project

Export - click the arrow to select  export options

Export to Excel - exports raw curve data to Excel for further graphing or analysis.

Export to CSV - exports raw curve data to csv file that can be opened in other spreadsheets for
further graphing or analysis

Mouse Position displays the current cursor location in terms of percentage and date

S Curve Type  - Select whether to graph by duration, physical % complete, cost or resource units.
Addtionally chose between standard S Curves, Trend Lines or Line of balance charts.

Time Units - Change the reporting time unit for Axis labels and reporting text.

Working Days - Display variances in working days

View - Select the view to show
Add View - create a new View
Manage Views - manage the views you have created

Add Text - add text to View
Manage Text - manage the text you have created

Font - change the font face and size of all graph text

Created with the Standard Edition of HelpNDoc: Free help authoring environment

S Curves tab

The S Curves tab defines which curves are displayed on the chart and how they are displayed. All settings
are saved as you set them and are used globally by Project Tracker i.e they are on a per user basis rather
than per project.

Click each dropwdown button to define how and whether the line is displayed

Drag the slider to set the width of the line

Click the color drop down to select the color of the line

Click the Style drop down to select the line type.

https://www.helpndoc.com/help-authoring-tool
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Labels - chose to show Data Labels or markers on curves 

Created with the Standard Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation

Gantt Chart Tab

The Gantt Chart allows gantt chart bars to be displayed behind the S curve to demonstrate which activities
are contributing to the S curve data.

Display Gantt Chart - specifies whether Gantt bars are displayed.

Gantt Lines Displayed - sets number of lines displayed. Using the arrow keys on the keyboard scrolls up
and down.

Shade Competed Activities - to color completed sections of activities

Ruling Lines - between Gantt lines

Show Status - changes the text colour activity name with activity status.

Critical Path - turn the critical path on or off in the Gantt chart

Show Baseline - turn baselines on or off in the Gantt chart

Collapse to level - chose the hierarchy level displayed in Gantt chart

Format Outline - Change the outline level colours in the Gantt chart

Completed Color - sets the color of the completed part of an activity

Incomplete Activity Color - general color of a Gantt bar

Baseline Color - general color of a Baseline bar

Opacity - sets the opacity level of the Gantt bar.

Created with the Standard Edition of HelpNDoc: Full-featured Help generator

View Tab

The view tab controls which items are displayed and sets some additional formatting.

https://www.helpndoc.com/help-authoring-tool
https://www.helpndoc.com/feature-tour
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Display Progress Status - adds progress related text at the top of the chart.

Dynamic Status - Provide dynamic progress feedback whilst moving mouse cursor up the forecast line.

Apply Weightings - only applicable to Asta Powerproject projects and duration curves. Overall Percent
Complete Weightings are applied to values.

Show Reports - creates dashboard, quality and activity reports

Show Progress Legends - adds key porgress lines and a further box containing key data. The box can be
dragged into the desired position.

Show End Date Lines - adds end date lines to the graphs to show key data points.

Period Graphs - Chose whether to show these and their display color. These can be shown for
Percentages or Units. 

Period Data Labels - chose to show Data Labels for  period graphs.

Comparison Baseline -  Set the baseline to be used in progress data and reports

Recovery Plan Finish Date - Set to draw a recovery line to a specific date

Created with the Standard Edition of HelpNDoc: Easily create PDF Help documents

Format Tab

The format tab controls how items are displayed and sets some additional tools.

Background - set the background color of the graph

Legend

This dialog allows the user to define the labels for the legend displayed on the graph.

https://www.helpndoc.com/feature-tour
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Date Axis - axis options. The Date Axis slice also determines the slice for Period Graphs. 

Data Table

This dialog defines options for the Date Axis

The Options tab sets date and currency formats.

The Week Numbering tab sets the week numbering system in the date zone.
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The Date Rows tab sets which date types are shown in the datezone

The Date Grid tab allows you to set the values displayed in the datezone. Click + to add or x to remove
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items. By 
clicking in the items the settings can be changed between Period and Cumulative, % and Units. The
description can be changed to show the required line. The Display Text can be changed for user defined
labels for the values.

Progress Axis - Select the required axis for left and right sides of the graph. These can be cumulative or per
period by % or units.

Created with the Standard Edition of HelpNDoc: Generate Kindle eBooks with ease

Help Tab

The Help tab 

Show Wizard - Shows the wizard if it has been turned off previously

Help - launches the help system.

Created with the Standard Edition of HelpNDoc: Free EBook and documentation generator

Main Drawing Area

https://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
https://www.helpndoc.com
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The main application area has 6 tabs

Graphs - the main tab displaying s curve graphs

Milestone Trend Analysis - allows creation of Milestone Trend Analysis reports

Progress Report - a text based report of project progress data

Dashboard - displays pie charts showing status of project

Project Quality - displays charts showing quality of project

Activity Report – lists filtered activities

Created with the Standard Edition of HelpNDoc: Free EPub producer

Filter Expander

The Filter expander is found on the left of the screen. Clicking the arrow opens or collapses the expander.
You can select certain WBS, activity code items, resources and/or a time slice to create filtered reports.

https://www.helpndoc.com/create-epub-ebooks
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If you are creating a line of balance graph an addtional tab will be displayed select a code(s) to produce
individual s-curves on.

Created with the Standard Edition of HelpNDoc: Produce online help for Qt applications

Raw Data Expander

The Raw Data expander is on the right hand side of the screen and displays the raw numbers used in
generation of curves.
If the duration curve is selected the data is shown in hours. This data is exported to Excel (csv file).

https://www.helpndoc.com/feature-tour/create-help-files-for-the-qt-help-framework
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Data can be edited to change the curves if required but this data cannot be saved.

Clicking on a line of data will display the activities that occur on that date in the Activity Details expander

Created with the Standard Edition of HelpNDoc: Free EPub producer

Activity Details Expander

The Activity Details expander is at the bottom of the screen and shows activities that occur on a date
selected in the Raw Data expander or the current date if the Dynamic Feedback option has been selected.

Created with the Standard Edition of HelpNDoc: Free EPub producer

Getting help

Please email contact@willmer.co.uk for support

Created with the Standard Edition of HelpNDoc: Free EPub producer

https://www.helpndoc.com/create-epub-ebooks
https://www.helpndoc.com/create-epub-ebooks
https://www.helpndoc.com/create-epub-ebooks
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Importing Projects

Projects are imported from Primavera P6, Microsoft Project and Asta Powerproject. There are several ways
of getting data from these applications.

Created with the Standard Edition of HelpNDoc: Free HTML Help documentation generator

Using the Wizard

The Wizard is displayed at start up unless it has previously been turned off. It allows you to select the most
popular items to create an S Curve report. For more formatting options use the relevant menu options as
shown in this help file. Available import options and are for Primavera P6 xer and direct Microsoft Project
import. If you wish to import from other software or using other methods such as P6 direct database use the
menu options on the Home menu.

If you don't want to see the Wizard again you can select Do not show this wizard again and then click
Finish. To reactivate the Wizard click the button in the Help menu.

Click Next to start the Wizard.

https://www.helpndoc.com
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Select P6 XER or Microsoft Project. Then Click import. You will then see the import dialogs.

Primavera P6

Select a project file and baseline(s) files. Baselines will be an xer file themselves. In P6 baselines should be
restored as projects, exported and then re added as baselines. Baseline(s) can be optionally given sensible
names for legends.

Default Hours per day is used for calculating progress report data in days.

Use Late Dates from Baseline 1 as Baseline 2 will create 2 baseline curves from one baseline. One for early
dates and one for late dates. 

Microsoft Project

Pre Requisites

1. Microsoft Project installed
2. Microsoft Project open and the project to import is opened.

PLEASE NOT DUE TO LIMITATIONS WITH MICROSOFT PROJECT BASELINES MUST BE TAKEN PRIOR
TO PROGRESS BEING ADDED.

Select the baselines you wish to import and optionally give them names..

If you only want to import Tasks that have been filtered click the Filtered Tasks only box.

Once the curves have been created click Next. Here you can select the type of curve required.
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Click Next. Chose from the post popular curve types.

Click Next and chose extra items to show.

Click Next and chose which legend lines to show in the Date Axis.
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Click Finish.

Created with the Standard Edition of HelpNDoc: Free HTML Help documentation generator

Primavera P6 Database

The P6 direct databse connection allows you to import data direct from a P6 database. This is easier than
using the xer or xml method as you won't need to export files for projects and baselines. Although no writing
is done to the database this is not recommended for corporate users who may be working with other users
on large enterprise databases as IT departments may not allow it.

Importing a project

Start Project Tracker and click the Primavera P6 dropdown button and then select the Primavera Database
import button on the Home tab of the ribbon.

Supported databases are SQL Server, Oracle and SQL Lite.

SQL Server

Select SQL Server as the Driver. Add Server Name, Database name, Privuser name and privuser password.
Alternatively you can type the connection string and use that if connecting to remore servers.

https://www.helpndoc.com
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Click Test to check the connection is OK and if successful click Connect to begin import.

Oracle

Select Oracle as the Driver. Add Host Name, Service name, Privuser name and privuser password.
Alternatively you can type the connection string and use that if connecting to remore servers or have
TSNNames.ORA set up.

Click Test to check the connection is OK and if successful click Connect to begin import.

SQLLite

Select SQL Lite as the Driver. Select the database name. Alternatively you can type the connection string
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Click Test to check the connection is OK and if successful click Connect to begin import.

From the following dialog select the project(s) you wish to import.

From the following dialog select the baseline(s) you wish to use.

If the selection contains multiple projects with different data dates you will need to select one to use.
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If the selection contains multiple projects a screen will show where the baselines are matched up. These
can be changed if required.

Click OK to import the project and baselines. An S Curve will be created.

Optionally set a weighting for each task against an Number UserField named Weighting 

Limitations

WBS Summary activities are not imported.

WBS

The wbs is imported and is used  in the Scope Filter.
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Global and Project Activity Codes

The codes are imported and are used  in the Code Filter.

Created with the Standard Edition of HelpNDoc: Create cross-platform Qt Help files

Primavera XER

Pre Requisites

1. Valid Primavera XER file

Importing a project

Start Project Tracker and click the Primavera P6 dropdown button and then select the Primavera P6 XER
import button on the Home tab of the ribbon.

Select a project file and baseline(s) files. Baselines will be an xer file themselves. In P6 baselines should be
restored as projects, exported and then re added as baselines. Baseline(s) can be optionally given sensible
names for legends.

Use Late Dates from Baseline 1 as Baseline 2 will create 2 baseline curves from one baseline. One for early
dates and one for late dates. 

If the file contains multiple projects with different data dates you will need to select one to use.

If the file contains multiple projects a screen will show where the baselines are matched up. These can be
changed if required.

https://www.helpndoc.com/feature-tour/create-help-files-for-the-qt-help-framework
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Click OK to import the project and baselines. An S Curve will be created.

Weightings

Optionally set a weighting for each task against an Number UserField named Weighting 

Limitations

WBS Summary activities are not imported.

WBS

The wbs is imported and is used  in the Scope Filter.

Global and Project Activity Codes

The codes are imported and are used  in the Code Filter.

Created with the Standard Edition of HelpNDoc: Free HTML Help documentation generator

Primavera XML

Pre Requisites

https://www.helpndoc.com
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1. Valid Primavera XML file

Importing a project

Start Project Tracker and click the Primavera P6 dropdown button and then select the Primavera P6 XML
import button on the Home tab of the ribbon.

Select a project file and baseline(s) files. Baselines will be an XML file themselves. In P6 baselines should
be restored as projects, exported and then re added as baselines. Baseline(s) can be optionally given
sensible names for legends.

Use Late Dates from Baseline 1 as Baseline 2 will create 2 baseline curves from one baseline. One for early
dates and one for late dates.

Click OK to import the project and baselines. If the file contains multiple projects with different data dates
you will need to select one to use.

If the file contains multiple projects a screen will show where the baselines are matched up. These can be
changed if required.



Project Tracker

38 / 73

ill be created.

Weightings

Optionally set a weighting for each task against an Integer UserField named Weighting 

WBS

The WBS is imported and is used  in the Scope Filter.

Global and Project Activity Codes

The codes are imported and are used  in the Code Filter.

Created with the Standard Edition of HelpNDoc: Full-featured Kindle eBooks generator

Microsoft Project

Pre Requisites

1. Microsoft Project installed
2. Microsoft Project open and the project to import is opened.

PLEASE NOT DUE TO LIMITATIONS WITH MICROSOFT PROJECT BASELINES MUST BE TAKEN PRIOR
TO PROGRESS BEING ADDED.

Importing a project

https://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
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Start Project Tracker and click the Microsoft Project dropdown button and then select the Microsoft Project
Direct Connection import button on the Home tab of the ribbon.

Select the baselines you wish to import and optionally give them names..

If you only want to import Tasks that have been filtered click the Filtered Tasks only box.

Click OK to import the project and baselines. An S Curve will be created.

Weightings

Optionally set a weighting for each task against field Number20

Limitations

Baseline duration data is spread evenly between the start date and finish date. 

How is the data imported and how are is the curve data calculated.

Project Data

Duration - The actual and remaining duration of the activity is accurately applied to working days.

Cost - The actual and remaining total cost of the activity is accurately applied to working days. 

Resource - The actual and remaining total work of the activity is accurately applied to working days.

Baseline Data

Duration - The duration of the baseline activity is spread evenly between the start and finish of the baseline
activity.

Cost - The  total cost of the baseline activity is accurately applied to working days. 

Resource - The  total work of the baseline activity is accurately applied to working days.

Project Hierarchy
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The hierarchy is imported and is used  in the Scope Filter.

Outline Codes

The codes are imported and are used  in the Code Filter.

Created with the Standard Edition of HelpNDoc: Easily create Qt Help files

Microsoft Project XML

Pre Requisites

1. Microsoft Project xml created in Microsoft Project

Importing a project

Start Project Tracker and click the Microsoft Project dropdown button and then select the Microsoft Project
XML file import button on the Home tab of the ribbon.

Select the baselines you wish to import and optionally give them names..

Select Smooth through non working time to ignore non working time and to average data over elapsed period
of activities to smooth curves.

Please note Filtered Tasks only option is not available for xml imports.

Click OK to import the project and baselines. An S Curve will be created.

Weightings

Optionally set a weighting for each task against field Number1 

Limitations

Baseline duration data is spread evenly between the start date and finish date. 

How is the data imported and how are is the curve data calculated.

https://www.helpndoc.com/feature-tour
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Project Data

Duration - The actual and remaining duration of the activity is accurately applied to working days.

Cost - The actual and remaining total cost of the activity is accurately applied to working days. 

Resource - The actual and remaining total work of the activity is accurately applied to working days.

Baseline Data

Duration - The duration of the baseline activity is spread evenly between the start and finish of the baseline
activity.

Cost - The  total cost of the baseline activity is spread evenly between the start and finish of the baseline
activity. 

Resource - The  total work of the baseline activity is spread evenly between the start and finish of the
baseline activity.

Project Hierarchy

The hierarchy is imported and is used  in the Scope Filter.

Outline Codes

The codes are not imported as they are not exported in an xml file.

Created with the Standard Edition of HelpNDoc: Create iPhone web-based documentation

Asta Powerproject

Pre Requisites

1. Asta Powerproject v11 or later installed
2. Asta Powerproject open and the project to import is opened.

Importing a project

Start Project Tracker and click the Asta Powerproject import button on the Home tab of the ribbon.

Select the baselines you wish to import and the default hours per day (used to calculate progress
information in days such as slippage values)

https://www.helpndoc.com/feature-tour/iphone-website-generation
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Click OK to import the project and baselines. An S Curve will be created.

Limitations

No limitations

How is the data imported and how are is the curve data calculated.

Project Data

Duration - The actual and remaining duration of the activity is accurately applied to working days.

Cost - The actual and remaining total cost of the activity is  accurately applied to working days. 

Resource - The actual and remaining total work of the activity is accurately applied to working days.

Overall Percent Complete Weightings can be used in s curve production.

Baseline Data

Duration - The duration of the baseline activity is accurately applied to working days.

Cost - The  total cost of the baseline activity is  accurately applied to working days. 

Resource - The  total work of the baseline activity is accurately applied to working days.

Project Hierarchy

The hierarchy is imported and is used  in the Scope Filter.

Code Libraries

The codes are imported and are used  in the Code Filter.

Work Breakdown Structure

The wbs is imported and are used  in the Code Filter.

Created with the Standard Edition of HelpNDoc: Full-featured multi-format Help generator
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Technical

Primavera P6 XER/XML Import
WBS used to create hierarchy for scope filters
Global and Project activity codes used to create structure for code filters
Weightings can be imported from a number user defined field named 'Weighting'
Only activities and milestones imported

Project Data

Duration - The actual and remaining duration of the activity is calculated using the working time on a
particular day.

Cost - The actual and remaining total cost of the activity is calculated using the working time on a particular
day as a proportion of the total cost of the activity.

Resource - The actual and remaining total work of the activity is calculated using the working time on a
particular day as a proportion of the total work of the activity.

Baseline Data

Duration - The actual and remaining duration of the activity is calculated using the working time on a
particular day.

Cost - The actual and remaining total cost of the activity is calculated using the working time on a particular
day as a proportion of the total cost of the activity.

Resource - The actual and remaining total work of the activity is calculated using the working time on a
particular day as a proportion of the total work of the activity.

Primavera P6 Databse import
WBS used to create hierarchy for scope filters
Global and Project activity codes used to create structure for code filters
Only activities and milestones imported

Project Data

Duration - The actual and remaining duration of the activity is calculated using the working time on a
particular day.

Cost - The actual and remaining total cost of the activity is calculated using the working time on a particular
day as a proportion of the total cost of the activity.

Resource - The actual and remaining total work of the activity is calculated using the working time on a
particular day as a proportion of the total work of the activity.

Baseline Data

Duration - The actual and remaining duration of the activity is calculated using the working time on a
particular day.

Cost - The actual and remaining total cost of the activity is calculated using the working time on a particular
day as a proportion of the total cost of the activity.

Resource - The actual and remaining total work of the activity is calculated using the working time on a
particular day as a proportion of the total work of the activity.
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Microsoft Project API import

Project Data

Duration - The actual and remaining duration of the activity is accurately applied to working days.

Cost - The actual and remaining total cost of the activity is accurately applied to working days. 

Resource - The actual and remaining total work of the activity is accurately applied to working days.

Baseline Data

Duration - The duration of the baseline activity is spread evenly between the start and finish of the baseline
activity.

Cost - The total cost of the baseline activity is accurately applied to working days. 

Resource - The total work of the baseline activity is accurately applied to working days.

Project Hierarchy

The hierarchy is imported and is used in the Scope Filter.

Outline Codes

The codes are imported and are used in the Code Filter.

Weightings

Optionally set a weighting for each task against field Number1 

Microsoft Project XML import

Weightings

Optionally set a weighting for each task against field Number1 

Limitations

Baseline duration data is spread evenly between the start date and finish date. 

How is the data imported and how is the curve data calculated.

Project Data

Duration - The actual and remaining duration of the activity is accurately applied to working days.

Cost - The actual and remaining total cost of the activity is accurately applied to working days. 

Resource - The actual and remaining total work of the activity is accurately applied to working days.

Baseline Data

Duration - The duration of the baseline activity is spread evenly between the start and finish of the baseline
activity.

Cost - The total cost of the baseline activity is spread evenly between the start and finish of the baseline
activity. 

Resource - The total work of the baseline activity is spread evenly between the start and finish of the
baseline activity.
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Project Hierarchy

The hierarchy is imported and is used in the Scope Filter.

Outline Codes

The codes are not imported as they are not exported in an XML file.

Asta Powerproject API import

Project Data

Duration - The actual and remaining duration of the activity is accurately applied to working days.

Cost - The actual and remaining total cost of the activity is accurately applied to working days. 

Resource - The actual and remaining total work of the activity is accurately applied to working days.

Overall Percent Complete Weightings can be used S Curve production.

Baseline Data

Duration - The duration of the baseline activity is accurately applied to working days.

Cost - The total cost of the baseline activity is accurately applied to working days. 

Resource - The total work of the baseline activity is accurately applied to working days.

Project Hierarchy

The hierarchy is imported and is used in the Scope Filter.

Code Libraries

The codes are imported and are used in the Code Filter.

Work Breakdown Structure

The WBS is imported and used in the Code Filter.

Created with the Standard Edition of HelpNDoc: Create help files for the Qt Help Framework

Updating Projects

Projects can be imported at any stage. For example if you have a file open and have set views and text you
can overwrite the existing data by re-importing the updated project. You will see a message asking whether
the project should be overwritten.

Created with the Standard Edition of HelpNDoc: Qt Help documentation made easy
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Earned Value Management

Project Tracker can operate in standard s curve mode or in EVA mode.

Project Tracker will show earned value for duration, cost or resource depending on which curve type is
selected.

To operate in EVA mode select the EVA curve type from the S Curves menu.

When this is selected the following changes are made;

The Actual Curve is renamed Actual Cost (AC)
The Forecast Curve is renamed Forecast at Completion (FAC)
The Baseline Curve is renamed a Planned Value (PV)
A new line is added for Earned Value (EV) which is the projects earned value

The Formal X Axis lines has a  new option for  Earned Value Management. 

Selecting this option will add new items to the axis for
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Earned Value (EV) - is also referred to as Budgeted Cost of Work Performed (BCWP). EV or BCWP
is the total cost of the work completed/performed as of a reporting date.

It is calculated as:

EV or BCWP = Baselined Cost × % Complete Actual

Schedule Variance (SV)  indicates how much ahead or behind the schedule a project is running.

It can be calculated using the following formula:

Schedule Variance (SV) = Earned Value (EV) − Planned Value (PV)

Cost Variance (CV) is a very important factor to measure project performance. CV indicates how
much over - or under-budget the project is.

CV can be calculated using the following formula:

Cost Variance (CV) = Earned Value (EV) − Actual Cost (AC)

Schedule Performance Index - is an index showing the efficiency of the time utilized on the project. SPI
can be calculated using the following formula:

SPI = Earned Value (EV) ⁄ Planned Value (PV)
OR

SPI = BCWP ⁄ BCWS
The formula mentioned above gives the efficiency of the project team in utilizing the time allocated for the
project.

An SPI value above 1 indicates the project team is very efficient in utilizing the time allocated to the project.

An SPI value below 1 indicates the project team is less efficient in utilizing the time allocated to the project.

Cost Performance Index is an index showing the efficiency of the utilization of the resources on
the project. CPI can be calculated using the following formula:

CPI = Earned Value (EV) ⁄ Actual Cost (AC)
OR

CPI = BCWP ⁄ ACWP
The formula mentioned above gives the efficiency of the utilization of the resources allocated to the project.

A CPI value above 1 indicates the efficiency of utilizing the resources allocated to the project is good.

A CPI value below 1 indicates the efficiency of utilizing the resources allocated to the project is not good.
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Created with the Standard Edition of HelpNDoc: Create help files for the Qt Help Framework

Understanding the S Curves

There are quite a few elements and option of the s curves. These are explained in this section.

Created with the Standard Edition of HelpNDoc: Free Qt Help documentation generator

S Curve Type

Project Tracker can produce s curves for duration, cost or resource effort. Select the required type from the
Settings Tab.

A duration s curve is based uses the duration of the task to calculate the curve. If an activity is 5 working
days long; 1 day per day will be added to the cumulative s curve totals.

An original duration s curve uses the original duration of the task to calculate actuals for the curve. This
means that if a task was originally 5 days long before actuals were applied potentially increasing the
duration only the original duration will be used.

Cost and resource graphs are based on the total allocation of each type to the activity and these are then
graphed cumulatively.

Created with the Standard Edition of HelpNDoc: Create iPhone web-based documentation

Actual

The Actual curve is derived from the duration (or cost or amount of resource) completed in the project.

If Activity A is 5 days complete and that is the only activity completed, the cumulative actual s curve will be
drawn to 5/(total duration) % at the data date.

If Activity A was complete but still was positioned after the data date the 5 days would be spread evenly over
the days between the start of the view and the data date. Ideally all projects should be recalculated after
progress has been applied to move incomplete work to after the data date and uncompleted work to after the
data date. However if this is not done Project Tracker will attempt a pseudo recalculation and spread any
completed tasks values across the available time.

The Actual Curve will always be drawn from the start of the view to the data date. It will never be drawn past
the data date.

The Actual curve can be configured from the S Curve tab.

Created with the Standard Edition of HelpNDoc: Easy EPub and documentation editor

Forecast

The Forecast curve is derived from the remaining duration (or cost or amount of resource)  in the project.

If Activity A has 5 days remaining and that is the only activity, the cumulative Forecast s curve will be drawn
to 5/(total duration) % from the data date.

https://www.helpndoc.com/feature-tour/create-help-files-for-the-qt-help-framework
https://www.helpndoc.com
https://www.helpndoc.com/feature-tour/iphone-website-generation
https://www.helpndoc.com
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If Activity A was incomplete but still was positioned before the data date the 5 days would be spread evenly
over the days between the date date  and the end date of the view. Ideally all projects should be recalculated
after progress has been applied to move completed work to before the data date and uncompleted work to
after the data date. However if this is not done Project Tracker will attempt a pseudo recalculation and
spread any uncompleted tasks values across the available time.

The Forecast Curve will always be drawn from  the data date. It will never start before the data date.

The Forecast curve can be configured from the S Curve tab.

Created with the Standard Edition of HelpNDoc: Create iPhone web-based documentation

Mix Line

The Mix curve is derived from the remaining duration (or cost or amount of resource)  in the project.

You can specify the ratio between activities in their early and late positions using the ration dropdown from
the Mix  Line in the S Curve menu option.

In this example there is a 50/50 ratio selected. If the activity in its earliest position is in week 1 and in it's
latest position in week 3. The 50/50 mix would draw the curve as if it were in week 2

If Activity A has 5 days remaining and that is the only activity, the cumulative  s curve will be drawn to 5/
(total duration) % from the data date.

If Activity A was incomplete but still was positioned before the data date the 5 days would be spread evenly
over the days between the date date  and the end date of the view. Ideally all projects should be recalculated
after progress has been applied to move completed work to before the data date and uncompleted work to
after the data date. However if this is not done Project Tracker will attempt a pseudo recalculation and
spread any uncompleted tasks values across the available time.

The  Curve will always be drawn from  the data date. It will never start before the data date.

The Mix  curve can be configured from the S Curve tab.

If the line exceeds or does not reach 100% it is likely the project has not been scheduled or there is an
issue with the logic in the plan

Created with the Standard Edition of HelpNDoc: Free EBook and documentation generator

EVA

This curve shows the projects Earned Value

Created with the Standard Edition of HelpNDoc: Full-featured Documentation generator
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Early

The Early curve is derived from the remaining duration (or cost or amount of resource)  in the project using
the earliest start and finish dates of activities.

If Activity A has 5 days remaining and that is the only activity, the cumulative  s curve will be drawn to 5/
(total duration) % from the data date.

If Activity A was incomplete but still was positioned before the data date the 5 days would be spread evenly
over the days between the date date  and the end date of the view. Ideally all projects should be recalculated
after progress has been applied to move completed work to before the data date and uncompleted work to
after the data date. However if this is not done Project Tracker will attempt a pseudo recalculation and
spread any uncompleted tasks values across the available time.

The Early curve will always be drawn from  the data date. It will never start before the data date.

The Early curve can be configured from the S Curve tab.

Created with the Standard Edition of HelpNDoc: Full-featured EBook editor

Late

The Late curve is derived from the remaining duration (or cost or amount of resource)  in the project using
the latest start and finish dates of activities.

If Activity A has 5 days remaining and that is the only activity, the cumulative  s curve will be drawn to 5/
(total duration) % from the data date.

If Activity A was incomplete but still was positioned before the data date the 5 days would be spread evenly
over the days between the date date  and the end date of the view. Ideally all projects should be recalculated
after progress has been applied to move completed work to before the data date and uncompleted work to
after the data date. However if this is not done Project Tracker will attempt a pseudo recalculation and
spread any uncompleted tasks values across the available time.

The Late curve will always be drawn from  the data date. It will never start before the data date.

The Late curve can be configured from the S Curve tab.

If the line exceeds or does not reach 100% it is likely the project has not been scheduled or there is an
issue with the logic in the plan

Created with the Standard Edition of HelpNDoc: Easily create Qt Help files

Baseline 1

The Baseline 1 curve is derived from the total duration (or cost or amount of resource)  in the baseline. Any
progress is ignored

The Baseline 1 curve can be configured from the S Curve tab.

Created with the Standard Edition of HelpNDoc: Free help authoring tool

Baseline 2

The Baseline 2 curve is derived from the total duration (or cost or amount of resource)  in the baseline. Any
progress is ignored

The Baseline 2 curve can be configured from the S Curve tab.

https://www.helpndoc.com/create-epub-ebooks
https://www.helpndoc.com/feature-tour
https://www.helpndoc.com/help-authoring-tool
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Created with the Standard Edition of HelpNDoc: Full-featured Documentation generator

Predicted

The Predicted curve is is based on the forecats curve data but will be influenced by the slippage and scope
growth at the data date.

If the project scope has grown by 2 days at the data date and the actual completed work at the data date is
20 days into the project we can assume the project is growing 1 day every 10 days. If the project still has
another 100 days of work (or cost or resource) to complete run the forecast curve will be have 10 days more
work (or cost or resource) than the target date. The forecast curve will try and maintain the profile of the
target curve as much as possible.

The Predicted Curve will always be drawn from  the data date. It will never start before the data date.

The Predicted curve can be configured from the S Curve tab.

Created with the Standard Edition of HelpNDoc: Create HTML Help, DOC, PDF and print manuals from 1
single source

Recovery

The Recovery curve is is based on the forecast curve data but will be influenced by the recovery end date set
in the Settings Tab.

The Recovery curve is designed to show how the curve would look for a recovery programme set to a
particular finish date.

The Recovery curve will try and maintain the profile of the forecast curve as much as possible.

The Recovery Curve will always be drawn from  the data date. It will never start before the data date.

The Recovery curve can be configured from the S Curve tab.

Created with the Standard Edition of HelpNDoc: Free CHM Help documentation generator

Weighting

If the project imported has weightings set against each activity the duration curve can be influenced by the 
weighting if the Weightings option is ticked in the Settings tab.

For example an activity with a weighting of 2 will contribute twice as much duration to the cumulative curve
as an activity with a weighting of 1. This can be useful for setting the relevant importance of activities.

Created with the Standard Edition of HelpNDoc: Free PDF documentation generator

Filtered Curves

By default a s curve chart is based on all the activities and milestones (not summary activities) in the
project. As a project may be made up of many phases or coded up in many different ways it may be desired
to create curves on sub sets of data i.e by trade or by floor. Curves can also be filtered by resource. 

Project Tracker makes this easy by importing activity codes, wbs and hierarchy along with activity data.

A filter can be based purely in scope or code or resource alone or a combination of all.

If a filter matches the criteria of a previously created view the chart title will carry the name of the view.

To set a scope filter open the Scope Expander.

https://www.helpndoc.com
https://www.helpndoc.com/help-authoring-tool
https://www.helpndoc.com/help-authoring-tool
https://www.helpndoc.com
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Click the check boxes of the items you wish to filter on. The s curve will redraw automatically. The progress
report will also be based on the filter.

To remove the filter untick the items.

The process for a code filter is identical.
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As it is for a resource. This gives the option of viewing team, individual or material resources. Material
Resources are only used when they are used as part as a filter. They are excluded from normal man
hour curves.

To base the filter on a time slice set the dates as required.

Once a filter has been created it can be saved into a View which can be printed automatically.

Created with the Standard Edition of HelpNDoc: Full-featured EBook editor

Dynamic Feedback

Dynamic status will display the progress status at a particular date. 

To turn this on check the box in the Settings tab.

https://www.helpndoc.com/create-epub-ebooks
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The values will change as the mouse is moved up or down the curve. The contents of the box are described 
here.

When in this mode the Activity Details expander will automatically load the activities occurring at that date.

It is possible to fix the status window and cursor position by clicking with the left mouse button anywhere on
the drawing area. To release the lock click again. Alternatively press F2 on the keyboard.

Created with the Standard Edition of HelpNDoc: Easily create Help documents

Progress Report

The text based progress report is found on the Progress Report tab of the main drawing area. This report
gives an explanation of how the data has been calculated. The report can be edited, saved and printed. A
summary of this data is printed at the top of the scurve if the Display Progress Status - has been set.

Project Progress Report  (Duration) Juniper Nursing Home
Project Progress Report 01 May 2011
Summary Progress

Actual 726.66 Days
Baseline 718.47 Days
Variance 8.19 Days
Percent Complete 10.19%
Planned Percent Complete 10.08%
Percent Complete Variance 0.11%
Slip -1 Days
Target at Completion

Target Finish Date 08/01/2014
Planned Finish Date 13/12/2013
Project Slip 26 Days
Target Total 7313.93 Days
Planned Total 7129.85 Days
Project Growth 184.08 Days

https://www.helpndoc.com/feature-tour
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S Curve Analysis
Initial analysis of the S Curve reveals the following about the status of the project...
* The project has grown in scope. (The Target S Curve finishes above the Baseline S Curve)
* The project has slipped. (The Target S Curve finishes to the right of the Baseline S Curve)
* The project is ahead of schedule. (The Actual S Curve is above the Baseline S Curve at the Data Date)
Project Growth
Analysis of the Baseline and Target S Curve data reveals the project has grown in scope by 184 Days, or 2.58%
i.e. Growth = Target  - Baseline  = 7314 Days - 7130 Days = 184 Days
i.e. Growth % = (Target / Baseline - 1) x 100% = ( 7314 Days/7130 Days - 1 ) x 100% = 2.58%
Project Slippage
Analysis of the Baseline and Target S Curve data reveals the project has slipped by 26 days, or 2.28%
i.e. Slippage = Target Duration  - Baseline Duration = 1164 Days - 1138 Days = 26 Days
i.e. Slippage % = (Target Duration / Baseline Duration - 1) x 100% = ( 1164 Days/1138 Days - 1) x 100% = 2.28%
Progress To Date
Analysis of the Actual and Baseline S Curve data reveals the project is 10.19 % complete as of the Data Date, while the
project should be 10.08% complete.
i.e. Actual % Complete = (Actual Total @ Date Date / Baseline Total @ Completion) x 100% = (727 Days/7314 Days) x
100% = 10.19%
i.e. Baseline % Complete = (Baseline Total @ Date Date / Baseline Total @ Completion) x 100% = (718 Days/7314 Days)
x 100% = 10.08%
The actual total of 727 Days should have been achieved by the 02/05/2011. Therefore the project has accelerated by 1
Days
i.e. Data date ( 01/05/2011) - ( baseline date 02/05/2011 ) = -1 Days
Forecast Analysis
At the data date the project had slipped by  0.55%  and scope had grown by  2.74%
As a result the project is forecasted to complete on the  14/01/2014  and the cumulative total is forecasted to be  
7494.39 Days

Created with the Standard Edition of HelpNDoc: Write eBooks for the Kindle

Progress Legends

If the Show Progress Legend option is turned on and a baseline has been imported a series of lines and a
further status box will be displayed.

Lines are drawn at baseline finish and target finish dates.

Lines are drawn to show the actual progress and planned progress.

https://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
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Created with the Standard Edition of HelpNDoc: Easily create iPhone documentation

Legend

The legend shows the lines included and thier line types. The legend can be dragged around the screen to
the desired position.

Created with the Standard Edition of HelpNDoc: Write EPub books for the iPad

Period Bar Graphs

Period Bar Graphs can show the cumulative values per x axis slice of Live and Baseline Data. These can be
useful to show periods of over or under work. It is particularly interesting as most planning software will not
graph durations.

The options to turn on and set colors for the period bar graph are set in the Settings Tab.

Created with the Standard Edition of HelpNDoc: Easy to use tool to create HTML Help files and Help web sites
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Trend Lines

Trend Lines are an alternative to standard S Curves.

Trend Lines are selected by changing the S Curve type from the Home menu.

The following are plotted to show the trend in project progress.

Schedule Performance Index - is an index showing the efficiency of the time utilized on the project. SPI
can be calculated using the following formula:

SPI = Earned Value (EV) ⁄ Planned Value (PV)
OR

SPI = BCWP ⁄ BCWS
The formula mentioned above gives the efficiency of the project team in utilizing the time allocated for the
project.

An SPI value above 1 indicates the project team is very efficient in utilizing the time allocated to the project.

An SPI value below 1 indicates the project team is less efficient in utilizing the time allocated to the project.

Cost Performance Index is an index showing the efficiency of the utilization of the resources on
the project. CPI can be calculated using the following formula:

CPI = Earned Value (EV) ⁄ Actual Cost (AC)
OR

CPI = BCWP ⁄ ACWP
The formula mentioned above gives the efficiency of the utilization of the resources allocated to the project.

A CPI value above 1 indicates the efficiency of utilizing the resources allocated to the project is good.

A CPI value below 1 indicates the efficiency of utilizing the resources allocated to the project is not good.

Created with the Standard Edition of HelpNDoc: Create help files for the Qt Help Framework
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Gantt Chart

A gantt chart can be displayed as well as the s curves. To turn this on check the Display Gantt Chart -
specifies whether Gantt bars are displayed in the Gantt Chart tab.

Placing the mouse over a gantt bar will give details about the activity.

Click on + or - to hide or expand summary activities

To scroll up or down if not all bars are displayed use;

Up or Down Arrow on keyboard
Page Up or Page Down 
Home or End

There are various options that can be used.

Display Gantt Chart - specifies whether Gantt bars are displayed.

Gantt Lines Displayed - sets number of lines displayed. Using the arrow keys on the keyboard scrolls up
and down.

Shade Competed Activities - to color completed sections of activities

Ruling Lines - between Gantt lines

Show Status - changes the text colour activity name with activity status.

Critical Path - turn the critical path on or off in the Gantt chart

Show Baseline - turn baselines on or off in the Gantt chart

Collapse to level - chose the hierarchy level displayed in Gantt chart

Format Outline - Change the outline level colours in the Gantt chart

Completed Color - sets the color of the completed part of an activity

Incomplete Activity Color - general color of a Gantt bar



Project Tracker

59 / 73

Baseline Color - general color of a Baseline bar

Opacity - sets the opacity level of the Gantt bar.

Created with the Standard Edition of HelpNDoc: Free PDF documentation generator

Line of Balance

Line of Balance graphs plot the S Curve for multiple disciplines or trades. This is very useful for detection of
clashes or where more than one trade is working at the same time.

To create a Line of Balance chart select the Line of Balance option from the S Curve Type area of the Home
tab.

Then open the Filter expander on the left of the screen. A new option will be shown for Line of Balance.
Select the disciplines you wish to graph. These are derived from the activity codes in the project. Additonally
you can use the other filter options to refine the data ie. show data just for Phase 1.

The project must be rescheduled/recalculated so that incomplete work starts after the status date and
completed work finishes before the status date to view accurate graphs. 

Actual values are shown as dotted lines, forecast as solid lines and if a baseline is displayed these are
shown as dashed.

A series of lines will be shown for each discipline selected.

Created with the Standard Edition of HelpNDoc: Easily create CHM Help documents

Reports

Created with the Standard Edition of HelpNDoc: Easily create HTML Help documents

Milestone Trend Analysis

Milestone Trend Analysis (MTA) is an easy-to-read combination of the history and prognosis of selected
project milestones. It is used to graphically illustrate time-related discrepancies.

https://www.helpndoc.com
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When milestones are updated, the completion dates are reforecast according to the progression of the
project. Connecting the interrelated symbols produces a curve that clearly shows the progression over time.
The best-case completion of the original plan is represented by a horizontal line. If this line is rising it
signifies a delay in the schedule; a falling line means that completion will be ahead of schedule.

Milestone data is imported alongside a normal import for an S Curve but is displayed on the Milestone Trend
Analysis tab of the main drawing area.

On the first import of data and when you want to initiate the Milestone Trends for the project click the New
button (ensure you have already imported the project data). 

The report will be produced with all milestones in the project on the data date.

If your project has many milestones you can filter by WBS or Activity Code by using the Scope expander as
used here. MTA reports will respect any views that have been selected.

At this point the data should be saved by clicking the MTS save button.

The report can be printed or copied to the clipboard using the respective buttons.

At the next data date you will re import the data into Project Tracker. Then click the MTA open button and
select the file saved last time for the MTA report.
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The file will be loaded and will include the latest data. Here you can see the project is in delay as the
milestone dates and increasing.

Save the data and repeat the process each data date.

Created with the Standard Edition of HelpNDoc: Free EPub producer

Project Quality Report

Project Quality reports the integrity of your project using thresholds to set the color of the display.

Reports can be printed or copied by clicking the tool buttons in the report

Click on a button or chart section to navigate to the activity report with the selected activities filtered on

The threshold levels can be set by clicking the Cog settings button as shown below.

https://www.helpndoc.com/create-epub-ebooks
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Created with the Standard Edition of HelpNDoc: Easy CHM and documentation editor

Activity Report

The Activity Report shows a list of all activities that are filtered on. Filters can be created from the Filter
scope, from dashboard reports or quality reports, or from the filter dropdown in the Activity Report window.

To turn on the Activity Report click Show Report in the Settings menu.

The Activity Report will display duration, cost or EVA data depending on which Curve type is selected.

Reports can be printed or copied to the clipboard

https://www.helpndoc.com
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Created with the Standard Edition of HelpNDoc: Generate EPub eBooks with ease

Dashboard Reports

Dashboard reports show pie charts of the following;

Start Date 
Finish Date
Duration
Progress
Work
Cost

Reports can be printed or copied by clicking the tool buttons in the report

Click on a pie section to navigate to the activity report with the selected activities filtered on

Created with the Standard Edition of HelpNDoc: Free Qt Help documentation generator

https://www.helpndoc.com/create-epub-ebooks
https://www.helpndoc.com
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Working with views

Views can be created of different curves to allow batch printing of filtered reports. Additionally text can be
added that are used on specific views for example thee could be 2 named views of the unfiltered curve one of
which contains text for internal use and one that doesn't.

Once views are created newly created Text can nominate a view to appear on.

To create view of the current curve click the Add View button on the Home Tab.

Add a name to the View, click Batch Print if you wish to automatically print the view in a batch and click
OK. 

When printing large projects it is now possible to print a curve with a subset of Gantt chart lines. This would
allow print outs by WBS whilst still showing the full curves. Useful for printing on multiple pages.

When you create a view you can set this by ticking the option as below.

Views are listed in the View section on the Home tab.

Views can be also be created here by clicking the + button.

Views can be deleted by clicking the x button.

As its likely a user will import a projects progress weekly or monthly as the project progresses they won't
want to keep recreating these views. To import the Views from that may have been created in a previous
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project click the Copy Views from..button. Select the file and the views will be imported overwriting any
views that may have been created in the current project.

Created with the Standard Edition of HelpNDoc: Free help authoring environment

Working with text

Text can be added to a chart.

Click the Add Text button in the Home Tab. The  mouse cursor will change to a pen. Click on the drawing
area where you wish to add the Text and a default item will be created.

The text item can be dragged around the chart to the desired position.

To change the Text and its attributes and to assign it to a view if required select the Manage Text button on
the Home tab.

To stop text add mode press Esc on the keyboard or Click the Add Text button in the Home Tab.

Created with the Standard Edition of HelpNDoc: What is a Help Authoring tool?

Exporting Data

Data can be exported to Excel if it is installed on the PC or to a csv file which can be opened in your favorite
spreadsheet for further data manipulation if neccessary.

Click the Export button in the Home tab and select either Export to Excel or Export to CSV.

If Export to Excel is selected Excel will open with the data imported. 

If CSV is select follw these steps;

Add a filename and click Save.

https://www.helpndoc.com/help-authoring-tool
https://www.helpauthoringsoftware.com
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If Export LOB Data is selected and a Line of Balance graph is active the planned and actual % of each code
seleted will be displayed.

Created with the Standard Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation

Saving Projects

To save a project either select the Save icon from the application menu or from the Home Tab.

If it is a newly imported project there will be a prompt for a file name.

Project Tracker creates an xml file.

If a saved project is being edited this file will be update on a Save.

Created with the Standard Edition of HelpNDoc: Easily create iPhone documentation

Opening Projects

To open a saved project select Open from the Ribbon Menu or select from the recent files list

Created with the Standard Edition of HelpNDoc: Easy CHM and documentation editor

https://www.helpndoc.com/help-authoring-tool
https://www.helpndoc.com/feature-tour/iphone-website-generation
https://www.helpndoc.com
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Closing a Project

To close a project select Close from the Ribbon Menu.

If the project has not need save this will be prompted for.

Created with the Standard Edition of HelpNDoc: Free Web Help generator

Printing a Project

Created with the Standard Edition of HelpNDoc: Easily create Qt Help files

Print Settings

To set print options for a project select Print Settings from the Ribbon Menu.

Set the desired orientation of the output and select a logo(s) if required by clicking the button.

Select the number of pages to print over. Note this gives one border per page. To ensure that weeks or
months end per page there may be blank space on the last page.

A time slice can be applied to the print out

https://www.helpndoc.com
https://www.helpndoc.com/feature-tour
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Legend Text can be edited which will be displayed on print ours and on screen curves.

The Project Name can be edited if required.
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Click Close to save settings which will be used on all output.

Created with the Standard Edition of HelpNDoc: Easily create Qt Help files

Preview

 To Preview output select the Preview button from the Home Tab.

Created with the Standard Edition of HelpNDoc: Easy EBook and documentation generator

Batch Printing

 To print all views set to Batch Print select the Batch Print button from the Home Tab.

Created with the Standard Edition of HelpNDoc: Easily create PDF Help documents

XML Schema

Xml file schema
When a project is saved in Project Tracker an XML file is saved which can be opened for future use.

There are 5 main child areas. All dates are stored in Coordinated Universal Time (UTC) format.

Project Details

https://www.helpndoc.com/feature-tour
https://www.helpndoc.com
https://www.helpndoc.com/feature-tour
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Activity Codes – list of activity codes imported and used for filtering

Outline Codes – list of WBS (P6) or Project Hierarchy (Microsoft Project and Asta) imported and used for
filtering.

Labour Resources – list of resources for filtering

Views – list of the views created in the project (all projects have a default view).

vCode and vScope hold id's of the activity code or outline filter applied to the view. If Batch is set to True it
will be included in a Batch print.
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Annotations – list of the text created in the project.

aView is the ID of the view it is assigned to. Location is the % value it is locked to on the S Curve graph.

Tasks – list of the task and time phased segments (Items) by day. Type 1 = live project, Type 2 = Baseline
1data, Type 3 = Baseline 2 data.

If a task is 5 days long there will be 5 entries for it; one for each day. If it is in both baselines and they are
both 5 days long there will be a total of 15 entries for each task.

Each Item has a record of its date, the duration minutes, cost and work on that day together with whether
work is complete on that day.
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Created with the Standard Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation
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